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Adobe Audition 2021 

4 – Recording 
 

There are several reasons why you might want to record sound in Audition. One obvious reason is to 

record speaking using a microphone, such as if you are recording an interview or preparing a 

podcast. 

Other times instead of a microphone you might have an external device connected to your computer 

(connected to your computer’s line input connection). For example you might want to transfer an 

existing recording on to your computer. Such as if you want to copy an old vinyl record or tape to 

your computer so you can save a digital copy. Or perhaps you’re at a live music event and want to 

record from the sound system into a computer. 

This section will focus on recording with a microphone while a later section will look at recording 

from other sound sources. 

Setting up your Input 
Before you can record sound into Audition, you need to make sure Audition knows where the sound 

will be coming from. Your computer might have onboard sound with your motherboard, a dedicated 

sound card and a USB headset plugged in. Any one of them could be used as a recording source so 

you need to tell Audition which one to use. 

Exercise 1. Setting your Input Source 

1. With Audition open go to the Edit menu, select Preferences and then select Audio Hardware. 

 

2. Choose the device you will be using for recording and then click OK. 

Note If you don’t have a suitable recording device such as a headset or microphone then read 

through the next sections anyway so you can be prepared for when you do have one. When 

you get to Exercise 5, you will be able to work with sample files that have already been 

recorded.  
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Exercise 2. Testing your input 

As we saw earlier, when sound is playing in Audition, a Levels meter at the bottom of the screen will 

show the volume level of what is playing. You can use that to check the volume levels before 

recording. 

1. Double-click the Levels meter at the bottom of the screen to activate it. Firstly this will ensure 

that your input device is actually working. Secondly it will let you see the levels of the sound 

coming into your computer. 

 

If you are able to adjust the recording level of your microphone or input device you can do it now to 

make sure your volume is not too loud or too quiet. You can also practice speaking without 

recording to get the volume right. You don’t need to have any sound files open to do this. 

2. Once you’re satisfied with the sound levels, double-click the levels meter again to turn it off. It 

will activate again when you begin recording. 

 

Exercise 3. Making a Voice Recording 

Time to create a new blank sound file to record in to. 

3. From the File menu select New and Audio File or press Ctrl Shift N. 

4. Fill in the New Audio File settings as shown below and click OK. 

 

Remember that the Sample Rate refers to the number of times per second that the computer will 

sample the recording. 44100 Hz is equivalent to CD quality audio. 

The Bit Depth refers to the range of possible sound values that can be recorded for each sample. 16 

bits (65,536 values) per sample is equivalent to CD quality but having a higher setting while 

recording doesn’t hurt. 

While recording, read the following sentence. Perhaps have a couple of practice tries before you 

start recording. 

  

http://www.oneil.com.au/pc/


Adobe Audition 2021  4 – Recording 
 

© Steve O’Neil 2021 Page 3 of 10 http://www.oneil.com.au/pc/ 

Welcome to Adobe Audition. 

In this exercise I am demonstrating the recording features of 

Audition. 

 

5. When you are ready, click the Record button in the Transport bar. 

6. Press the Stop button (or press the Spacebar) when you want to finish recording. 

 

 

 

When it has finished recording, your new recording will be shown as a waveform. The whole 

waveform will be selected when the recording is finished. 

 

It might take a couple of tries before you’re happy with the recording. If you’re not satisfied with 

your recording then simply press Del on your keyboard while it is selected to delete the recorded 

audio (if it’s not still selected press Ctrl A to select all of the recording). Once the recording has been 

cleared, you are ready to try again. 

7. Once you are satisfied with the results, press Ctrl S to save your recording. 

The save options allow you to specify the filename, the save location, file format and quality 

settings. The file name is already filled in based on the title you put in the new file settings, but you 

can change the filename if you prefer something else. 

Stop Record 
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For now we’ll stick with the default WAV format to save it in since it’s a format that saves with no 

loss in quality. There might be occasions where you need to save in a different format and we’ll look 

at some of them later on. 

8. Make sure the Location is set to a suitable place to save your file and click OK to save the 

recording. 

 

Exercise 4. Using Punch and Roll 

If you are recording a longer segment and make a mistake, you probably don’t want to start the 

whole recording over again. You also might find it hard to start right on the spot where you made 

the mistake since you’d want to match your tone of voice and speaking pace to what you had been 

saying earlier. 

Punch and Roll helps you to re-record part of your recording when you need to and then continue on 

with your recording. 

1. Make sure your previous recording is still open. We’re going to re-record the second line while 

leaving the first line as it is. 

2. Locate the part of your recording just before the words In this exercise and click on that spot to 

place your play head there. 

3. Right-click on the Record button and select Punch and Roll Mode to turn on this mode of 

recording. 
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Tip You can also press Alt Shift Spacebar to immediately begin recording with Punch and Roll 

Mode activated. 

When Punch and Roll mode is activated 2 things will happen when you record. Audition will play a 

bit of your audio before the spot you have selected. This is referred to as Pre-Roll. With default 

settings this will be 5 seconds though this amount can be changed in Audition’s settings. This allows 

you to listen to the recording as you prepare to record again. This can help you to match your tone 

and cadence. As soon as it reaches the designated spot, Audition will begin recording, over-writing 

what was already recorded. 

This time when we record we are changing a couple of words. Take a look at the text below so you 

know what will need to be recorded. 

Welcome to Adobe Audition. 

In this exercise I am demonstrating the Punch and Roll recording 

features of Audition. 

The first line won’t change and Audition will play that as it was already recorded. While that part is 

playing, it might be useful for you to speak over the top of it to help match what was already 

recorded. As soon as it reaches the second line, continue reading as it records. 

4. Click the Record button (or press Alt Shift Spacebar) to begin recording in Punch and Roll mode. 

5. Stop recording using the Stop button ◼ or the Spacebar as you get to the end of the sentence to 

record. 

If you’re not happy with the recording you can simply try it again as Punch and Roll will still record 

from the same spot. 

6. When you no longer need Punch and Roll, you can right-click the Record button again to turn it 

off. 

 

7. Press Ctrl S to save the changes to your recording. 

Exercise 5. Using the Healing Brush 

When you are recording audio, it’s always a good idea to minimise background noises as much as 

possible. Close doors and windows, turn off nearby fans or other electronic devices. Unless you’re 

using a professional recording studio though, there will probably be some background noises in your 

recording that you would rather not have. 

Sometimes that additional noise is difficult to avoid. For example if you film an interview outside, 

edit the video in Adobe Premier and then edit the audio from that video clip in Audition, you might 

have sound from wind on the microphone and other outdoors sounds. 

In this exercise we will look at a couple of ways to reduce background noise from your recording. 

1. Open the file called Cleanup.wav. 
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In the sample file there are a couple of things we might want to fix. Firstly, around the 8 second 

mark there is a noise from an object on a desk falling over during the recording. Secondly, there is 

some constant background noise largely caused by things like a nearby fan and open window. Since 

the recording was made on a laptop computer, the computer’s fan also added some extra noise. 

First, we’ll look at removing the unwanted sound from the middle. 

2. Zoom in on the sound at approximately 8 seconds. 

3. Click a little bit before that point and play so that you can hear the sound of the object falling 

over. 

 

While we are in Waveform Editor view, we can see the amplitude (volume) of different parts of the 

sound represented as the green peaks. Sometimes that isn’t enough visual information. 

4. From the View menu select Show Spectral Frequency Display. This will add a spectral view 

below your Waveform view. 

Spectral Frequency View represents your sound as colours. The bottom part of the view shows the 

lower frequencies (deeper sounds) while the upper part shows higher frequencies (higher pitched 

sounds). The colours show how strong the sound is in that area. So, if the colours are brighter 

toward the bottom in a certain part of your file, it shows that there is a lot of low frequency sound in 

those areas. 

Tip You can also turn Spectral Frequency Display on and off by pressing the F9 key or by clicking 

the icon on your toolbar. 
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Here are some examples showing how certain sounds might look in spectral view. 

Bass Guitar (mostly low frequency) 

 

Hi-hat symbol (mostly high frequency) 

 
Guitar playing

 

Woman Singing

 
 

When you look at our sound in the Spectral Frequency Display you can see that the sound we want 

to remove looks a lot sharper and less natural than the sound from the speaking. In many cases in 

spectral view, it is far easier to see certain sounds than it is in waveform view. In fact, unwanted 

sounds will often stand out in spectral view even more than in this example. 
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If you are a regular Adobe Photoshop user then you may already be familiar with the spot healing 

brush tool which lets you paint over parts of a photo that need blemishes quickly removed. Audition 

has a spot healing brush that works in the same way. While in spectral view, you can use the spot 

healing brush to paint over parts of the sound that you want to remove. 

5. Click the Spot Healing Brush icon on the 

toolbar (or press B on your keyboard). 

Your mouse pointer will now be a circle shape when you move your mouse over the spectral view. 

The circle indicates the size of the area you will paint over. Just like Photoshop, you can adjust the 

size of the brush circle by pressing the square bracket keys [ ] on your keyboard. 

6. With your mouse over the spectral view, press the [ and ] keys on your keyboard to adjust the 

size of your brush until it is similar to the size shown below. 

 

Paint over the brighter colours that represent the sound we need to remove. 

 

When you are finished painting, Audition will remove those frequencies and fill in the space as well 

as it can with the sound from around that area. In a stereo file, painting on one channel will also 

paint the same area on the other channel. If you only want to do one channel, remember you can 

click the buttons to the right to turn a channel on or off. 

7. Click a little before the fixed area and play the sound to hear the result. 
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Exercise 6. Using Noise Reduction 

1. Press Home on your keyboard to move to the start of the file (or scroll to it using one of the 

other methods shown earlier). 

 

2. Play the first part of the sound to hear the noises before the talking begins. 

You will hear some mouse clicks which can be clearly seen in the spectral view. Since they are before 

the talking, they are easily removed since we can delete that whole section. What is not so easily 

removed is that faint humming sound since that continues through the entire file, not just at the 

start. Removing background noises like that involves 2 key steps. 

a) Select a sample of the sound to be removed by creating a Noise Print. 

b) Use the Noise Reduction options to remove that sampled noise from your sound. 

Creating a noise print is an important step since that tells Audition what kind of sound you want 

removed. It’s a bit like telling the computer “hear what this sounds like – that’s what we want to get 

rid of in the rest of the file”. The best type of noise print is taken from a part of the file that only 

contains the sound you want to remove. This is why it can be a good idea to make sure there is a few 

seconds of silence before whatever you are recording. In the example we are using, there is a little 

over 2 seconds in the recording before the talking starts which gives plenty of room for a noise print. 

3. Activate the Time Selection tool by clicking the  icon on the toolbar or pressing the letter T. 

4. Select a section of the file that doesn’t contain any talking. 
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A section at the beginning of the file where there is only background noise would be a good choice. 

If we didn’t have any blank space at the start or end of the recording you could use a slight pause 

during the speaking. 

5. From the Effects menu, select Noise Reduction / Restoration and then Capture Noise Print (Or 

press Shift P). 

A message may appear letting you know the noise print has been captured. If you’d rather not see a 

message each time you capture a noise print, click the Don’t show this alert again option. 

 

Now that we’ve captured a noise print, we’re ready for the noise reduction options. 

6. From the Effects menu, select Noise Reduction / Restoration and then Noise Reduction 

(Process) (Or press Ctrl Shift P). 

If we hadn’t already captured a noise print, we could do it here using the button near the top. 

7. Click Select Entire File. If we didn’t already have anything selected, then applying the noise 

reduction options would apply to the whole file. 

8. Just as in earlier exercises, we can use the preview button in the bottom corner of the options to 

hear how our changes affect the sound. Try adjusting the Noise Reduction options to the right 

and left and preview to hear the difference at different amounts. 

9. Set the Noise Reduction to approximately 80-90% and set the Reduce by setting to 

approximately 10 decibels. Preview to hear the difference. 

 

Often it takes a bit of trial and error to get the settings right. Not enough reduction and you still have 

a lot of the unwanted background noise. Too much noise reduction can leave your recording 

sounding un-natural. Too little noise reduction often sounds better than too much. 

10. Click on Advanced near the bottom to display some advanced options. 

11. The Spectral Decay Rate setting can help reduce the watery sound that sometimes results from 

noise reduction. Set it to approximately 10%. 

12. Turn on the Output Noise Only option and preview the sound. While this option is ticked you 

will only hear the sound that is being removed. This is helpful to make sure you aren’t removing 

too much of the important sounds. If you preview your sound while this option is selected, you 

should hear very little of the speaking. 

13. Turn the Output Noise Only option off and click Apply to make the changes. 

14. Now you can trim the silence from the beginning and end of your sound file and save the 

changes. 
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